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Einleitung 

 
EndNote ist ein Literaturverwaltungsprogramm mit dem einfach und effizient bibliographische 
Daten (Bücher, Zeitschriftenaufsätze, WWW-Seiten, etc.) verwaltet werden können. Es steht 
derzeit in der Version X6.0 für Windows (XP, Vista ,7 und 8) sowie für Macintosh-Systeme 
(OS X) zur Verfügung1.  
 
Das Programm erfüllt alle Anforderungen (Datenerfassung, -speicherung, -verwaltung und -
ausgabe), die für die effektive Verwaltung von Quellen und Daten erforderlich sind. 
 
Über eine eigene Schnittstelle wird das speziell für bibliographische Daten entwickelte 
Austauschformat Z39.50 genutzt, um in externen bibliographischen Datenbanken direkt 
recherchieren und die Informationen in das eigene System übertragen zu können. 
 
Die Ausgabe von Datensätzen kann in sehr unterschiedlichen Ausgabeformaten erfolgen. 
Über „Add-Ins“ für die Textprogramme Word, OpenOffice.org Writer 3 (nur kompatibel mit 
Windows) oder Apple Pages und einer Vielzahl von Vorlagen wird die schnelle Einbindung 
der Informationen in eigenen Texten ermöglicht. Verweise auf zitierte Titel und das Erstellen 
von Literaturverzeichnissen sind weitgehend automatisiert.  
 
Auch Abbildungen und andere Objektelassen sich in EndNote komfortabel verwalten und in 
die Texte einbinden. 
 
Vorteile: hohe Konfigurierbarkeit; flexibler und vielseitiger Datenimport; Z39.50 Schnittstelle; 
ab Version 8 Unterstützung des Unicode-Zeichensatzes; Add-Ins für Textprogramme; hohe 
Anzahl fertiger Vorlagen; internationaler Standard; synchronisierbar mit EndNote Web; 
EndNote app für iPad. 
 
Nachteile: keine Unterstützung des deutschen MAB2 Formats; nur eingeschränkter 
Netzbetrieb möglich; lediglich in englischer Version erhältlich. 
 

1 Datenstruktur in EndNote 

 

 Eine Datenbank (Library) in EndNote kann (ab Version 8) theoretisch eine unbeschränkte 
Anzahl an Datensätzen beliebiger Größe beinhalten. Empfohlen wird eine max. Anzahl 
von ca. 100.000 Sätzen. 

 Es sind 52 Datenfelder definiert. In jedem Datenfeld (mit Ausnahme des Feldes Image) 
können mehrere, durch einen Zeilenumbruch getrennte Einträge stehen. Die Bedeutung 
der einzelnen Felder wird durch das spezielle Feld Reference Type festgelegt. Außer den 
45 vorgegebenen Reference Types2  kann der Benutzer 3 eigene Typen definieren bzw. 
bei Bedarf bestehende verändern. 

 Im Feld Image/File Attachments (ab Version 10 auch im Feld PDF können Verweise auf ) 
Bilddateien oder andere Objekte (z. B. MS Excel, MS PowerPoint Dateien) gespeichert 
werden.3 

 Die Felder für Autoren, Titel, Jahr, Seiten, Abbildungen und URL sind mit zusätzlichen 
Funktionalitäten (Prüfungen, Sortieroptionen, usw.) versehen und sollten nur für die 
vorgesehenen Inhalte verwendet werden.  

 

                                            
1
 http://endnote.com/en/requirements + http://endnote.com/downloads/available-updates 

2
 Die wichtigsten Typen sind: Journal Article, Book, Edited Book, Book Section, Report, Thesis. Mehr 

Informationen zu den deutschen Entsprechungen im EndNote Handbuch: 
http://www.endnote.de/handbuch  
3
 Einige Funktionalitäten für das Einbinden von externen Dateien sind erst ab Version 7 verfügbar. 

http://endnote.com/en/requirements
http://endnote.com/downloads/available-updates
http://www.endnote.de/handbuch
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2 Grundkonfiguration von EndNote 

 

 Nach der Installation4 sollten einige Grundeinstellungen geändert werden. Dieses 
geschieht über die Programmfunktion Edit -> Preferences (Abbildung 1): 

 

Abbildung 1:. EndNote Preferences 

 Unter Libraries werden die Datenbanken definiert, die EndNote beim Start 
automatisch öffnen soll. 

 Im Display Fonts Fenster kann die Schriftart für die Anzeige gewählt werden. Falls 
sämtliche Unicode-Zeichen darstellbar sein sollen, muss hier eine Schriftart gewählt 
werden, die diesen Zeichensatz unterstützt (z. B.: Arial Unicode MS, Tahoma, 
Lucida). 

 Unter Reference Type sollte der Referenztyp gewählt sein, der in den anzulegenden 
Libraries am häufigsten vorkommt (Standardeinstellung ist Journal Article). Über die 
Schaltfläche Modify Reference Types können die Definitionen der Reference Types 
geändert werden.  

                                            
4
 Windows: http://www.endnote.de/instwin 

  Macintosh: http://www.endnote.de/instmac  

http://www.endnote.de/instwin
http://www.endnote.de/instwin
http://www.endnote.de/instmac
http://www.endnote.de/instmac
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 Um eine korrekte Sortierung von deutschsprachigen Titeln zu erreichen, sollten unter 
der Option Sorting weitere Wörter eingetragen werden, die beim Sortieren von 
Titelanfängen und Personennamen nicht mit berücksichtigt werden sollen. Es 
empfiehlt sich, die Liste Author field um die Einträge „von“, „van“,  die Liste Title 
Field mit „der“, „die“, „das“, „ein“ und „eine“ zu erweitern. 

 Unter Display Fields werden die Felder festgelegt, die in den Spalten der 
Datensatzliste erscheinen sollen (max. 8 bis Version X5, ab X6 max. 10). 

 Unter Duplicates werden die Felder definiert, die für eine Dublettenprüfung 
herangezogen werden sollen. 

 Unter Folder Locations können die Standardverzeichnisse für die EndNote Dateien 
festgelegt werden. 

 Unter Find Full Text kann der von der FU bereitgestellte Verlinkungsservice SFX 
eingerichtet werden. Hierzu muss die Option OpenURL aktiviert und unter OpenURL 
Path folgende Serveradresse eingegeben werden: http://sfx.kobv.de/sfx_fub 

 

 Achtung: Sämtliche Einstellungen unter Preferences gelten für alle Libraries. Die 
Definition der Reference Types wird in der Datei EndNoteRefTypeTable.xml im 
Verzeichnis …\Dokumente und Einstellungen\EndNote gespeichert. 

 
 

3 Dateneingabe und Verwaltung 

3.1 Eingabe von Daten 

 

 Das Neuanlegen einer Datenbank geschieht durch Aufrufen des Eintrags New im 
Menü File. Es sollte darauf geachtet werden, dass dabei nicht versehentlich eine 
bestehende Library überschrieben wird. EndNote Libraries werden mit der 
Dateierweiterung „*.enl“ abgespeichert. Zu jeder EndNote Datei *.enl gehört immer 
ein gleichnamiger Data Ordner, der u.a. die PDF Dateien enthält, die sich in der 
Datenbank befinden. 

 

 Um einen Datensatz einzugeben, wird aus dem Menü References der Eintrag New 
aufgerufen (Strg/Ctrl+N). Es öffnet sich das folgende Fenster (Abbildung 2): 

 

Abbildung 2: EndNote new reference 

http://sfx.kobv.de/sfx_fub/
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 Je nach Wahl des Reference Type erhalten die Eingabefelder unterschiedliche 
Bezeichnungen. Der Reference Type „Generic“ enthält alle zur Verfügung stehenden 
Felder mit der entsprechenden systeminternen Bezeichnung. 

 

 Die Autoren sollten in der Form Nachname, Vorname eingegeben werden. Mehrere 
Autoren müssen durch einen Zeilenwechsel voneinander getrennt werden. Handelt 
es sich um eine Körperschaft bzw. Institution, muss der Eintrag mit einem Komma 
enden (z. B. „Freie Universität Berlin,“) um zu vermeiden, dass die spezielle 
Namensfunktion von EndNote den Eintrag als Personennamen wertet.  

 

 Titelangaben sollten am Ende keinen Punkt oder andere Satzzeichen enthalten. 
Diese werden erst bei der Ausgabe der Daten gesetzt. 

 

 Seitenangaben sollten ohne Kürzel wie „S.“ oder „p.“ eingeben werden. Auch hier 
erfolgt das Einfügen der Zeichen erst bei der Datenausgabe.  

 

 „Term lists“ vereinfachen die Dateneingabe und gewährleisten die Homogenität der 
Einträge. EndNote legt standardmäßig die Listen Author, Journals und Keywords an 
und verknüpft diese mit den Einträgen der entsprechenden Felder. Wenn in einem 
Datenfeld, das mit einer Term List verknüpft ist, neue Daten eingetippt werden, 
gleicht das Programm die Eingabe mit der Liste ab. Ist ein Eintrag vorhanden, schlägt 
es diesen vor. Wird keine Entsprechung gefunden, erscheint beim Eintippen der 
Eintrag rot. Mit dem Abspeichern des Satzes wird der Eintrag in die Term List 
übernommen. 

 

 Die Listen können über die Menüpunkte Tools / Open Term Lists, Define Term 
Lists und Link Term Lists bearbeitet, angelegt bzw. um Feldverknüpfungen ergänzt 
werden. Auch das Einlesen von Einträgen externer Datenquellen ist möglich. Die 
Liste der Zeitschriftentitel kann außerdem durch bis zu 3 verschiedene Kürzel ergänzt 
werden. Je nach Definition des Output Styles, kann EndNote bei der Erstellung von 
Bibliographien die Kürzel statt dem vollständigen Zeitschriftentitel verwenden. 

 
 

3.2 Suchen und Bearbeiten von Datensätzen 

 

Beim Öffnen einer Library wird zunächst ein Listenfenster angezeigt. Jeder Datensatz 
erscheint in einer Zeile (Abbildung 3):  

 

Abbildung 3: EndNote Browse List 
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 Eine Vorschau auf einzelne Sätze erhält man durch einen Klick auf Preview in der 
Statusleiste des Fensters. Ab Version X6 kann die Darstellung der Fenster mit der 
Option ‚Layout‘ rechts unten angepasst werden. Die Darstellung der Vorschau 
entspricht dabei dem ausgewählten Style. 

 

 Größe des Fensters und Breite der Spalten lassen sich über die üblichen 
Mausfunktionen festlegen. Welche Felder in den Spalten angezeigt werden, ist in den 
Preferences (siehe: 2 Grundkonfiguration von EndNote ‚Display Fields‘) definiert. 

 

 Ein Klicken auf eine Spaltenüberschrift bewirkt das auf- oder absteigende Sortieren 
der Liste nach dem ausgewählten Feld. Durch das Eintippen eines Buchstabens oder 
Wortanfangs gelangt man automatisch zu dem 1. Eintrag, der mit diesem beginnt. 

 

 Über die Suchfunktion kann die komplette Datenbank nach bestimmten Kriterien 
durchsucht werden. Die vom Programm ermittelten Einträge werden anschließend im 
Library Fenster dargestellt. In der Statuszeile des Fensters wird die Anzahl der 
Treffer genannt (Abbildung 4): 

 

Abbildung 4: EndNote Search 

 Häufig verwendete Suchanfragen können über Options ->Save Search gespeichert 
und für spätere Anfragen (auch in anderen Datenbanken) genutzt werden. Für die 
abgespeicherten Suchanfragen verwendet EndNote automatisch die 
Dateierweiterung „*.enq“. 

 

 Die erweiterte Suchfunktion lässt sich so konfigurieren, dass die gefundenen Einträge 
zu einer bereits ermittelten Treffermenge hinzugefügt werden (Option Add to 
Showing References), bzw. aus der Treffermenge entfernt werden (Option Omit 
from Showing References).  Eine bereits erstellteTreffermenge kann mittels der 
Option Search Showing References ein weiteres Mal gezielt durchsucht werden. 

 

 Markierte Einträge einer Ergebnisliste (auch mehrere) werden durch Enter (oder 
einem linken Doppelklick) geöffnet und können dort feldweise bearbeitet werden.  

 

 Über das Kontextmenü (rechte Maustaste) werden Einträge einer Liste hinzugefügt, 
kopiert oder gelöscht. Dabei gelten auch die windowsweiten Tastenkürzel: <Strg + c> 
= kopieren, <Strg + v> = einfügen, <Strg + a> = alle markieren, usw.  

 

 Im Library Fenster können mehrere Datensätze markiert werden. Auch hier gelten  
windowsüblichen Tastenkombinationen: <Strg + linke Maustaste> markiert einen 



 7 

zusätzlichen Eintrag, <Shift + linke Maustaste> markiert alle Sätze zwischen dem 
bereits markierten und dem angeklickten Eintrag. 

 

 Auf diese Weise lassen sich Datensätze auch in andere Libraries  kopieren. Sind 
mehrere Libraries gleichzeitig geöffnet, geschieht dieses am schnellsten über drag 
and drop bzw. copy/paste.  

 

 Achtung: eine automatische Dublettenprüfung findet dabei nicht statt. 
 
 

3.3 Sortieren und Filtern 

 

 Die Funktion Sort References ermöglicht das Sortieren nach abgestuften Kriterien 
(Abbildung 5):  

 

Abbildung 5: EndNote Sort List 

 Die Sortierung bezieht sich dabei stets nur auf die Liste der Datensätze, die im 
Library Fenster momentan sichtbar sind. Bereits gebildete Treffermengen können so 
nachträglich sortiert werden. Wörter, die bei der Sortierung nicht mit berücksichtigt 
werden sollen, müssen zuvor im Preferences Menü definiert werden. 

 

 Im Library Fenster markierte Datensätze können über die Funktion Show Selected 
References bzw. Hide Selected References (rechte Maustaste) gezielt gemeinsam 
angezeigt (oder versteckt) werden. Diese Anzeigeform dient nicht nur der besseren 
Übersicht, sondern erleichtert zudem die Änderung mehrerer Datensätze in einem 
Arbeitsschritt. 
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 Die Funktion Tools -> Change and Move Fields erlaubt die gezielte Manipulation 
der momentan sichtbaren Datensätze (Abbildung 6): 

  

Abbildung 6: EndNote Change and Move Fields 

Erlaubte Änderungen sind : 

 neue Inhalte am Anfang oder Ende eines Feldes hinzufügen 

 Feldinhalte komplett ersetzen 

 einzelne Felder löschen oder deren Inhalte in ein anderes Feld verschieben 

 Verschieben von Feldinhalten in ein anderes Feld. 

 Neu mit Version X6: Formatierung der Schreibweise eines Feldes mit Change Case ; 
verfügbar sind z.B. lowercase, UPPERCASE oder Capatilize Each Word. Das 
Textfeld ist bei dieser Option grau hinterlegt. 

 

 Das gezielte Ersetzen von Teilen eines Feldinhaltes ist (ab Version 8) über die 
Funktion Edit -> Change Text möglich, bezieht sich dann aber auf die gesamte 
Library. Ab Version X6 ist diese Funktion zu finden unter Edit -> Find and Replace 
(Ctrl+R). 

 

 Achtung: Diese Änderungen lassen sich nicht rückgängig machen. 
 
 

3.4 Dublettenprüfung 

 

 Die Funktion References -> Find Duplicates markiert in einem Library Fenster die 
Datensätze, die als dublett erkannt werden. Die gekennzeichneten Datensätze lassen 
sich danach gezielt verschieben (z. B. in eine extra für diese Zwecke angelegte 
Library) oder löschen. 

 

 Die Kriterien, die für die Prüfung herangezogen werden, werden über die 
Preferences festgelegt. Standardmäßig werden die Felder Author, Year und Title 
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geprüft (Abbildung 7). Je nach Definition der Kriterien, lassen sich so die Regeln für 
die Dublettenprüfung lockern oder enger fassen. 

 

Abbildung 7: EndNote Preferences Duplicates 

Achtung: Eine automatische Dublettenprüfung ist nur beim Import von externen Dateien z.B. 
im RIS-Format möglich, nicht aber bei der manuellen Eingabe von Sätzen, dem Direkten 
Export oder bei der Übernahme von Daten, die über Z39.50 Abfragen in die Datenbank 
eingelesen werden. 

 

4 Einbinden von externen Datenquellen (Connection Files) 

 

 EndNote verfügt über eine eigene Z39.50 Schnittstelle5 mit der in verschiedenen 
externen Datenbanken direkt aus dem Programm heraus recherchiert werden kann. 
Im Lieferumfang von EndNote ist im Ordner „Connections“ eine Vielzahl von 
vorgefertigten Connection Files enthalten. In diesen Dateien des Typs “*.enz“ sind 
alle benötigten Informationen definiert, die für Zugriff, Recherche und Einlesen der 
Daten benötigt werden. Nicht alle der ausgewiesenen Datenbanken sind lizenzfrei, 
die meisten Bibliothekskataloge können jedoch auch ohne eine spezielle Kennung 
oder Passwort erreicht werden.  

 

                                            
5
 Z39.50 ist ein speziell für den Austausch bibliographischer Daten entwickeltes Protokoll. Es ermög-

licht eine systemübergreifende Abfrage von Datenbanken, unabhängig von deren Struktur. Einen 
Überblick bietet: Z39.50: an overview [Dateityp: *.html] (2001); Siehe: http://www.biblio-
tech.com/html/z39_50.html [letzter Zugriff: 05.04.2013]. 

http://www.biblio-tech.com/html/z39_50.html
http://www.biblio-tech.com/html/z39_50.html
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 Sowohl Zugangsdaten als auch Datenformate können sich mit der Zeit ändern, bei 
Import-Problemen mit einer Datenquelle sollte daher zunächst die entsprechenden 
Connection File überprüft werden. Auf den Web-Seiten des EndNote Herstellers 
werden laufend aktualisierte Versionen für die verschiedenen Datenbanken 
angeboten.6 

 Für einige lizenzpflichtige bibliographische Datenbanken werden von der Freien 
Universität Berlin entsprechende Connection Files zur Verfügung gestellt.7  

 

 Das Abfragen einer externen Datenbank setzt eine bestehende Internetverbindung 
voraus. Das Herstellen der direkten Verbindung zu einer Datenbank erfolgt über die 
Funktion Tools -> Online Search: 

 

 Über die Funktion Edit -> Connection Files -> Open Connection Manager können 
besonders häufig genutzte Datenbanken für die Auswahl unter Tools -> Online 
Search markiert werden. Der Connection Manager dient außerdem der Konfiguration 
der Zugangsdaten und der Definition der Regeln für das Einlesen der Daten. 

 

 Achtung: Wenn die Anzahl der von der FU lizenzierten Zugriffe auf eine Datenbank 
erschöpft ist, wird zwar eine Verbindung zum Datenbankanbieter aufgebaut, beim 
Abschicken der 1. Suchanfrage erhält man jedoch die Fehlermeldung „Database 
unavailable.“ Die Suchanfrage muss dann zu einem späteren Zeitpunkt erneut 
durchgeführt werden. 

 
Je nach Einstellung werden die gefunden Referenzen entweder in einem Zwischenspeicher 
abgelegt oder direkt in die aktive Library eingelesen. Sicherer ist es, mit dem Online- bzw. 
Local Library Mode zu arbeiten und zu importierende Daten erst einmal zu prüfen bevor sie  
in eine bereits existierende Datenbank übernommen werden. So können diese Sätze über 
References -> Change and Move Fields mit zusätzlichen Informationen (etwa zur 
recherchierten Datenbank und Datum der Recherche) zu ergänzen. 
 
Achtung: eine Dublettenprüfung findet nicht statt. Bei größeren Datenmengen sollte daher 
die Dublettenprüfung nachträglich angestoßen werden oder die Daten zunächst in eine 
separate Library exportiert und anschließend mit der Option Discard Duplicates in die 
eigentliche Library importiert werden. 
 
 

5 Einlesen von externen Daten (Import Files) 

 

Die Definition der Regeln für das Einlesen und Umkodieren von bibliographischen Daten, die 
nicht über die Z39.50 Schnittstelle recherchiert worden sind, erfolgt in den Import Filtern. Das 
Ausgabeformat für die Daten ist von Datenbank zu Datenbank sehr verschieden und kann 
sich im Laufe der Zeit auch ändern. Zu jedem speziellen Format muss ein entsprechender 
Filter eingerichtet sein. Ohne diesen können die Daten nicht korrekt eingelesen werden. Dem 
Anwender steht eine große Anzahl an vorgefertigten Dateien zur Auswahl. Laufend 
aktualisierten Fassungen lassen sich außerdem auf der EndNote Homepage kostenlos 
herunterladen.8 Für die von der FU lizenzierten Datenbanken bietet die Universitätsbibliothek 

                                            
6
 Endnote Connection Files  (Thomson ISI ResearchSoft Inc.); Siehe: 

http://endnote.com/downloads/connections [letzter Zugriff:05.04.2013]. 
7
 Für die von der FU lizenzierten SilverPlatter-Datenbanken stehen speziell angepasste Connection 

Files zur Verfügung: Endnote Connection files für Silverplatter-Datenbanken [Dateityp: *.enz (Zugriff 
nur für FU-Angehörige)] (Freie Universität Berlin, Universitätsbibliothek); Siehe: : http://www.ub.fu-
berlin.de/service_neu/literaturverwaltung/hilfe/ [letzter Zugriff: 05.04.2013]. 
8
 Endnote Import Filter [Dateityp: *.html] (Thomson ISI ResearchSoft Inc.); Siehe: 

http://endnote.com/downloads/filters. 

http://www.ub.fu-berlin.de/service_neu/literaturverwaltung/hilfe/
http://www.ub.fu-berlin.de/service_neu/literaturverwaltung/hilfe/
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weitere Import Filter an. In den meisten Fällen müssen die Ergebnisse einer Recherche 
zunächst auf dem lokalen Rechner abgespeichert werden. Bei einigen Datenbankanbietern 
(Web of Knowledge, WorldCat) können die Ergebnisse auch direkt an das EndNote 
Programm übergeben werden. 

 

5.1 Import von zuvor gespeicherten Dateien 

 

 Beim Abspeichern der Rechercheergebnisse in einer Datenbank ist darauf zu achten, 
dass das Ausgabeformat mit dem Import Filter übereinstimmt. Wenn dieses der Fall 
ist,  übernimmt EndNote die gespeicherten Datensätze in die aktive Library und zeigt 
die importierten Datensätze in der temporären Gruppe Imported References an. Zu 
diesem Zeitpunkt ist es empfehlenswert, diese Sätze über Change and Move Fields 
mit zusätzlichen Informationen (etwa zur recherchierten Datenbank und Datum der 
Recherche) zu ergänzen. 

 
Die Regeln für einen Import Filter können über Open Filter Manager (-> Edit -> Import 
Filters) bearbeitet bzw. erweitert werden.  
 

5.2 Direkter Import 

 
Einige Datenbankanbieter und Bibliotheksportale (z.B. FU-Online Katalog, FU-Digitale 
Bibliothek, Web of  Knowledge oder WorldCat) bieten die Möglichkeit, die Ergebnisse einer 
Recherche über den Browser direkt an EndNote weiterzureichen. Die Bezeichnungen für 
diesen Vorgang sind recht unterschiedlich und lauten beispielsweise „Export to Reference 
Software“, „Save to Citation Manager“, „Direct Import", usw. (Abbildung 13): 

 



 12 

 
 
Abbildung 13. Primo an der FU Berlin, Speichern im Citation Manager Format 
 

Der Server des Anbieters sendet an das Browserprogramm eine Datei des Typs „*.enw" 
bzw. „*.end“. Wenn diese Dateinamenserweiterungen mit EndNote verknüpft sind, übergibt 
das Programm die Datei mit den Datensätzen direkt an EndNote. 
 
Das lokale Abspeichern der Datei und das Anstoßen des Import-Vorgangs entfallen. Es 
muss lediglich die Library angegeben werden, in welche die Datensätze übernommen 
werden sollen.  
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Je nachdem, um welche Datenbank es sich handelt, muss in einem EndNote Dialog noch 
der entsprechende Import Filter ausgewählt werden. Für den FU Online-Katalog und das 
Bibliotheksportal Primo der FU wird der Import Filter für das Format RefMan RIS benötigt. 
 
Achtung: Bei diesem Vorgang findet keine Dublettenprüfung statt. 
 

 

6 Gruppieren von Datensätzen 

 
Ab Version X1.0 können mit EndNote bis zu 500 Gruppen pro Library definiert sein. Jeder 
Datensatz einer Library kann dabei nur einmal mit einer einzelnen Gruppe verknüpft werden. 
Ein und derselbe Datensatz kann dennoch in mehreren unterschiedlichen Gruppen 
vorkommen. 
 

 

Abbildung 14. Gruppenfunktionalität 

Zusätzlich stellt EndNote dem Anwender zwei temporäre Gruppen zur Verfügung. Unter 
Search Results finden Sie immer die Ergebnisse der letzten Suchanfrage innerhalb einer 
Library. Datensätze, die Sie aus EndNoteWeb importieren, sind mit der Gruppe Transferred 
References verknüpft.  
Ab Version X6 ist diese Gruppe nicht mehr sichtbar, da mit der  Funktion Sync die 
EndNoteWeb Daten mit den lokalen Daten automatisch im Abstand von 15, 30 oder 60 
Minuten synchronisiert werden bzw. mit jeden Öffnen/Schließen der EndNote Datenbank. 
 
Werden die Sätze aus einer Gruppe gelöscht, wird lediglich die Verknüpfung zur Gruppe 
entfernt. Der Datensatz ist dann keiner Gruppe mehr zugeordnet und nur über All 
References auffindbar. Möchten Sie mehrere Datensätze aus einer Gruppe heraus komplett 
löschen, sollten Sie diese innerhalb der jeweiligen Gruppe markieren und zu All References 
wechseln. Die Markierungen aus der Gruppe werden dabei übernommen und die Sätze 
können gemeinsam gelöscht werden. 
 
Hinweis: Die EndNote Suchfunktionalitäten (Suchen, Ersetzen, Dublettenkontrolle, usw.) 
beziehen sich stets auf die gesamte Library und können nicht gruppenspezifisch verwendet 
werden.  
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7 Erstellen von Bibliographien 

 

7.1 Definition des Ausgabeformats (Output Styles) 

 
Für die Ausgabe der Literaturangaben in Form einer Bibliographie oder in Zitaten muss 
genau definiert werden, in welcher Form die Ausgabe erfolgen soll. Einzelne Verlage und 
Zeitschriften haben genaue Vorschriften für diese Angaben, die sehr unterschiedlich sein 
können. 
 
Die Definition für die Formate erfolgt in sogenannten Styles (Dateierweiterung "*.ens"). 
EndNote liefert für viele amerikanische Zeitschriften vorgefertigte Styles, für deutsche 
Zeitschriften müssen hingegen die Formate selbst definiert werden. 
 
Am einfachsten ist es, zunächst einen Style zu wählen, der der gewünschten Ausgabe am 
ehesten entspricht und diesen den eigenen Bedürfnissen anzupassen. Hierzu wird über Edit 
-> Output Styles -> Open Style Manager der Style zunächst mit Edit geöffnet, um dann 
über den Befehl Datei -> Save As eine Kopie zu erstellen und diese anschließend zu 
bearbeiten. 
 
Da die Ausgabe für Bücher meist anders formatiert werden muss als die für 
Zeitschriftensätze, sollten für jeden verwendeten Reference Type entsprechende Regeln für 
die Citations bzw. Footnotes und der Bibliography definiert werden.  
 
Reference Types, die in einem Style nicht berücksichtigt sind, werden entsprechend den 

Regeln für den Generic Type ausgegeben. 

 
Wird ein komplett neuer Style definiert, sollte zunächst die Ausgabe für das 
Literaturverzeichnis (Bibliography) durch eine einfache Berücksichtigung der einzelnen 
Felder gestaltet werden. Die im Style definierten Formatangaben lassen sich am schnellsten 
im Vorschaufenster ( Preview ) der Kurzlistenanzeige überprüfen. 
 
Weil Angaben für einzelne Datenfelder in einigen Sätzen vorhanden sind, in anderen jedoch 
nicht, treten jedoch schnell Probleme auf. Wenn etwa beispielsweise bei einer 
Literaturangabe die Jahresangabe unbekannt ist, dürfen bei der Ausgabe keine Klammern 
ohne Inhalt auftreten. Für die Erstellung von Styles gibt es deshalb einige Regeln und 
Sonderzeichen, die es ermöglichen, bestimmte Ausgabebedingungen zu formulieren. 
 

 Regel 1: Jeder Text, der nicht durch ein Leerzeichen von einem Feld getrennt ist, 
hängt von dem Feld ab; d. h. er wird nur ausgegeben, wenn das Feld auch 
vorhanden ist. Z. B.: Author (Year). Die Klammern gehören zur Jahresangabe und 
erscheinen nur, wenn Year vorhanden ist. 

 Regel 2: Das vorausgehende Feld hat Vorrang vor dem nachfolgenden. Z. B. 
Volume:Issue, der Doppelpunkt erscheint, wenn Volume vorhanden ist. 

 Regel 3: Bei der Ausgabe mehrerer Leerzeichen hängt das erste vom Feld ab, die 
nachfolgenden nicht; sie werden in jedem Fall ausgegeben. 

 Regel 4: Unabhängiger Text (d. h. Text, der durch Leerzeichen von den Feldern 
getrennt ist) erscheint immer. 

 
Zeichen mit besonderer Bedeutung sind: 

 °  (Option-Space, Link Adjacent Text): Spezielles Leerzeichen, das die Trennung 
vom Feld nicht aufhebt. Wenn im Template „Editor°ed.“ steht, erscheint bei 
Vorhandensein eines Herausgebers bspw. „Meyer ed.“, wenn kein Herausgeber 
vorhanden ist, wird auch nichts ausgegeben. 
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 |  (Forced Separation) trennt ein Zeichen, das eigentlich vom Feld abhängig 
wäre. Z. B.. Volume|:Issue bewirkt, dass der Doppelpunkt nur ausgegeben wird, 
wenn Issue vorhanden ist. 

 ^  Für die Felder Author, Editor und Pages können Deskriptionszeichen  
hinzugefügt werden, die zwischen Singular und Plural unterscheiden. Die 
unterschiedlichen Textformen werden dann durch ^ getrennt. Z. B.: 
Seite:^Seiten:°Pages. 

 ` Zeichenkette`  Ausgabe eines Textes, der zugleich Feldname ist. Z. B.: 
`Editor`°Editor erscheint als "Editor Meyer" bzw. gar nicht, wenn kein Herausgeber 
vorhanden ist. 

 
 
Außer den Formatierungsanweisungen im Template können für Zitatangaben und 
Bibliographie weitere Angaben gemacht werden, z. B. wie Autorennamen zu behandeln sind, 
wie mit weiteren Namen verfahren werden soll, bzw. wie diese sortiert werden müssen.  
 
Für die Bibliographie kann zusätzlich unter Layout angegeben werden, welche Informationen 
vor, bzw. nach jeder Referenz (Nummerierungen, bzw. Notes oder Abstracts) aufgeführt 
werden sollen. 
 

7.2 Einbindung in das Textprogramm Word 

 
Das Add-In CWYW (Cite While You Write) von EndNote wird bei der Installation automatisch 
in den Textprogrammen Word oder OpenOffice.org Writer 3 eingebunden und ermöglicht ein 
rasches Auffinden der EndNote Datensätze bzw. die Formatierung der Fußnoten und der 
Bibliographie.  
 
Über Extras -> EndNote, bzw. über die ebenfalls mitinstallierte Symbolleiste, werden die 
benötigten Befehle direkt im Textprogramm zur Verfügung gestellt (Abbildung 14).  
 

 
Abbildung 15. Endnote Cite While You Write Commands 

 Go To EndNote wechselt in das EndNote Programm.  

 Insert Citation -> Find Citation... öffnet innerhalb des Textprogramms ein EndNote 
Suchfenster, um den gewünschten Datensatz schnell lokalisieren zu können. 

 Update Citations and  Bibliography formatiert Zitate, Fußnoten und Bibliographie, 
maßgebend sind dabei die Formatierungen des gewählten Styles. 

 Insert Selected Citation(s) fügt den gerade in EndNote markierten Eintrag in den Text 
ein. 

 Edit & Manage Citation(s) ermöglicht die Bearbeitung des im Textprogramm 
eingefügten EndNote Eintrags, um etwa Seitenzahlen hinzufügen zu können. 

 Insert Note weist dem Eintrag einen zusätzlichen Kommentar zu, der bei einigen Styles 
in der Bibliographie mit berücksichtigt wird. 

 Edit Library Reference(s) öffnet den Editiermodus für die entsprechende Referenz in 
der geöffneten EndNote Library. 
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 Unformat Citation(s) entfernt sämtliche durch Endnote durchgeführten Formatierungen. 
Übrig bleiben die so genannten Temporary Citations, mit deren Hilfe EndNote die 
jeweiligen Zitatangaben den Datensätzen der Library zuordnet. Je nach Voreinstellung 
besteht eine Temporary Citation aus den Feldern Author, Year sowie der Satznummer. 
Um die Zitate in formatierter Form auszugeben, muss der Befehl Update Citation and  
Bibliography (s. o.) ausgeführt werden. 

 Convert to plainText entfernt bei einem bereits formatierten Text sämtliche Temporary 
Citations. Sämtliche Verknüpfungen zur EndNote Library werden damit entfernt, übrig 
bleiben die formatierten Zitate, Fußnoten und Endnoten sowie das Literaturverzeichnis. 

 Export Traveling Library erstellt eine eigene EndNote Datenbank anhand der im Text 
eingefügten Daten aus der ursprünglichen Library. Achtung: im Text über EndNote 
eingefügte Bilddaten oder andere Objekte werden nicht mit berücksichtigt. 

 Find Figure… fügt die in EndNote erfassten Bilddateien, Tabellen oder sonstige Objekte 
ein.  

 Cite While You Write Preferences konfiguriert das Add-Inn und legt beispielsweise fest, 
ob die eingefügten Temporary Citations laufend aktualisiert werden, welche Tastenkürzel 
bestimmte Funktionen auslösen, oder wo EndNote Bilddateien oder Tabellen im Text 
einfügen soll. 

 Help ruft die EndNote Hilfefunktion auf. 

 
 
 

8 Sichern und Exportieren 

 
Alle vorgenommenen Änderungen an der Datenbank werden von EndNote automatisch 
gespeichert. 
 
Nicht alle Arbeitsvorgänge können rückgängig gemacht werden. Daher ist es sinnvoll, vor 
Änderungen an der Library über File -> Save a Copy… eine Sicherungskopie zu erstellen. 
 
Zur kompletten Sicherung einer Datenbank gehören: 

 Die EndNote Library 

 Das eventuell vorhandene Unterverzeichnis *.dat (dort werden Bilddateien und 
externe Objekte gespeichert) bzw. der dazugehörige Data-Ordner. 

 Modifizierte, auf die Library zugeschnittene Import Filter, Styles und Connection Files 

 EndNote Preference Dateien, ab Version 8 v. a. die Datei EndNoteRefTypeTable.xml 

 Alle Dokumente, die mit Hilfe einer Library erstellt worden sind 
 
 

9 EndNote Web 

 
Die Firma Thomson Reuters, Anbieter der Software EndNote und der bibliographischen 
Datenbank ISI Web of Knowledge, betreibt seit Ende 2006 auch EndNote Web, ein 
webbasiertesLiteraturverwaltungsprogramm. 
  
Anwender können in einer eigenen, webbasierten Datenbank ihre Referenzen importieren, 
eingeben und verwalten und diese Daten anschließend über das Internet ausgewählten 
Anwendern bereitstellen.  
 
Vorraussetzung ist eine einmalige Anmeldung bei einem der Dienste. Dank einer 
campusweiten Lizenz für ISI Web of Knowledge, können alle Angehörigen der Freien 
Universität Berlin ein oder mehrere Accounts einrichten. Dies kann entweder unter 
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http://www.webofknowledge.com oder http://www.myendnoteweb.com erfolgen. Inaktive 
Accounts werden nach 3 Monaten vom Betreiber der Dienste gelöscht. 
 
Ist der ISI Web of Knowledge bzw. EndNote Web Account einmal erstellt, gelangt der 
Anwender in seinen persönlichen Bereich: 

 
 

 

Abbildung 17. EndNote Web Startseite 

 

9.1 Interoperabilität zwischen EndNote Web und ISI Web of Knowledge 

 
Die enge Verzahnung der Internetdienste ISI Web of Knowledge und EndNote Web 
ermöglicht eine recht enge Verknüpfung zwischen beiden Anwendungen. 
  
So können im Web of Knowledge recherchierte Datensätze direkt in die EndNote Web 
Datenbank des Anwenders kopiert werden: 

 

 

Abbildung 18. Darstellung eines Satzes im Web of Science (Web of Knowledge) 

 

http://www.webofknowledge.com/
http://www.myendnoteweb.com/
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Abbildung 19. Übertragung eines Satzes zur Endnote Web Datenbank 

In der Endnote Web Darstellung eines aus dem Web of Knowledge importierten Satzes 
stehen eine Reihe zusätzlicher Funktionalitäten und Verknüpfungen zu dem ursprünglichen 
Satz zur Verfügung, die teilweise auch laufend aktualisiert werden (Times cited). 

 

 

Abbildung 20. Darstellung des importierten Satzes in EndNote Web 

Im Web of Knowledge werden Datensätze, die bereits in die EndNote Web Datenbank 
übernommen wurden, durch ein speziellen Link gekennzeichnet, der zum EndNote Web 
Datensatz führt: 

 

Abbildung 21. ISI Web of Science Darstellung eines EndNote Web Datensatzes 
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9.2 Daten mit anderen Teilnehmern gemeinsam nutzen 

 
Durch die Web-basierte Architektur bietet EndNote Web eine Reihe von Funktionalitäten und 
Lösungsansätzen, die über die Möglichkeiten eines reinen „Desktop“-Programmes 
hinausgehen und das gemeinsame Bearbeiten und Nutzen von Daten in Arbeitsgruppen 
ermöglichen. So können etwa Datensätze eines EndNote Web Ordners einem bestimmten 
Kreis anderer Teilnehmer zugänglich gemacht werden. Anhand einer Liste von Email 
Adressen kann der Anwender selbst bestimmen, welche weiteren Teilnehmer (lesenden oder 
Lesenden- und Schreibenden) Zugriff auf bestimmte Inhalte erhalten sollen.  

 

 

Abbildung 22. Endnote Web: Share Folder Funktion 

In den Accounts der anderen Teilnehmer erscheinen die Datensätze ein einem speziellen 
Bereich Group Shared by Others/ Von anderen Benutzern freigegebene Gruppen und 
können bei Bedarf von dort in die eigenen Ordner kopiert werden: 

 

 

Abbildung 23. Endnote Web: Ansicht eines Shared Folders 

Je nach Einstellung können diese Sätze von den anderen Teilnehmern entweder nur 
eingesehen oder aber auch editiert werden. Somit eignet sich diese Funktionalität besonders 
gut für das gemeinsame Bearbeiten einer EndNote Datenbank. Mittlerweile ist es möglich, 
auch Anhänge (z.B. PDF-Dateien) zu speichern.  
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9.3 CWYW mit EndNote Web 

 
Ein zusätzliches Add-in für das Textprogramm Winword ermöglicht zwar einen direkten 
Datenaustausch zwischen dem Textprogramm und der EndNote Web Datenbank, aber die 
Literaturangaben können dabei nur nach vorgegebenen Output Styles formatiert werden, 
eine Anpassung der im EndNote Web hinterlegten Zitierregeln durch den Anwender ist 
derzeit nicht möglich. Das Programm ist daher als vollwertiges 
Literaturverwaltungsprogramm nur eingeschränkt nutzbar. 

 
 

9.4 Datenaustausch mit EndNote Web 

 
 
Seit Version X6 werden die Daten zwischen der Web- und Desktop Anwendung synchron 
gehalten, sodass nach einmaliger Einrichtung des EndNote Web Zuganges in der Desktop-
Version -> Edit -> Preferences -> Sync (Abbildung 24) , diese in zeitlichen Abständen 
abgeglichen werden. 

 

Abbildung 24. Einrichten des Datentransfers EndNote <-> Endnote Web über Edit > 
Preferences 

Der Austausch zwischen EndNote Web und älteren Programmversionen von EndNote bzw. 
anderen Literaturverwaltungsprogrammen muss über einen Export / Import-Vorgang 
erfolgen, etwa im „RefMan RIS Format.“  
 

9.5 EndNote app für das iPad 

 
Ein Synchronisieren der Daten ist auch mit der EndNote iPad app möglich (Abb. 25). 
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Abbildung 25. Oberfläche der EndNote apps auf dem iPad3 
 

10 EndNote Online Handbuch 

 
Seit Anfang April 2012 gibt es das Online Handbuch Informationsmanagement mit EndNote - 
ein situationsorientiertes Handbuch, ausgearbeitet von der Universitätsbibliothek Heidelberg 
und der Firma Adept Scientific. Studierende, Mitarbeiter und Einrichtungen der Freien 
Universität können auf das Handbuch kostenlos zugreifen. Dafür ist eine einmalige 
Registrierung nötig. Als Abo-ID gilt die bei der Registrierung angegebene E-Mail Adresse. 
 
Registrierung und Zugriff nur über http://www.endnote.de/handbuch/. 
 
 
Das Handbuch kann auch lokal heruntergeladen werden: 
Macintosh: ENHB.zip-Datei 
Windows: ENHB.exe-Datei 
 

http://www.endnote.de/handbuch/
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